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Overview of the Reports Module

A report is a formatted view of data that exists in the GE Digital APM database. Reports provide you with a
way of formatting information for display, export, and printing purposes.

You can create a report from query results, dataset results, or by importing a report that was saved to an
external location. After you create a report, you can save it and run it repeatedly. Like other items, reports
are saved in the Catalog and can be accessed via hyperlinks on a dashboard.

To create a report, you will use APM Report Designer Plug-in for Visual Studio. If you want to create a
report within GE Digital APM, Microsoft SQL Server Business Intelligence Development Studio must be
installed on the client machine.

After saving a report the Catalog, you can view the report by using the Report page. Note that you will
need the following to view reports:

+  You should have configured the SQL Server Report Server.

+ View/Execute permissions on the Catalog folder in which the report is located.

+ Atleast View privileges on all families included in the underlying query or dataset.

Access the Report Page

Before You Begin

+ An administrative user must create and save reports using the Reports Designer.

Procedure

In the module navigation menu, select Tools > Reports.
The Report page appears, displaying a list of all reports saved in the Catalog. The Catalog item caption is
displayed as the title to identify the report.

Report

ComprehensiveAnalysis Public\Meridium\Modules\RCA\SSRS\ComprehensiveAnalysis

Functional Test Calibration Report Public\Meridium\Modules\Calibration Management\Reports\Functional Test Calibration Report

Discrete Calibration Report Public\Meridium\Modules\Calibration

WeightScale Calibration Report Public\Meridium\Modules\Calibration Manage rt

Analog Calibration Report Public\Meridium\m

Family Security Assignments by Group ID  Public\Meridium\Modules\Administrati J\Security Reports\Family Security Assignments by Grc

Overview of the Reports Page

This page displays the information about the Report:

+ Name: The name of the report.

» Path: The Catalog file path where the report is saved.

+ Caption: The caption of the report that you have provided in the Catalog.
+ Creator: The name of the person who created the report.

+ Date: The date when the report was accessed.
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On this page you can, do the following:

+ View the reports that you have created.
+ View the reports that you have accessed recently.
+ View the reports from the Catalog folder.
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Core Analysis: Report Analysis Workflow

Core Analysis processes leverage GE Digital APM data to identify opportunities for business improvement.
When the process identifies such an opportunity, a Performance Recommendation is raised to
communicate the need and track the required work. You can use the Report Analysis Workflow process to
identify opportunities or needs for improvement based on generated reports that identify bad actors or
high-impact failures.

In the following workflow diagram, the blue text in a shape indicates that a corresponding description has
been provided in the sections that follow the diagram. For more information, refer to the topic
Interpreting the Workflow Diagrams.

Report Design
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Report Results

.

Analyst
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Start on page 5

Run the Report on page 5

Review Report Results on page 6

Opportunity Exists? on page 6

Manage Performance Recommendations on page 6

oA WD e

Start

Persona: Analyst

To satisfy a specific business problem, a GE Digital APM User initiates a core analysis to apply standard
data analysis techniques.

Run the Report
Persona: Analyst

Execute a report to produce results, and modify the report design to achieve the desired result.
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Review Report Results
Persona: Analyst

Analyze the report results. The report can identify bad actors or high impact failures for further analysis. In
the analysis of report results, consult other forms of GE Digital APM data.

Opportunity Exists?
Persona: Analyst

If a GE Digital APM User identifies an opportunity or need for improvement, then a Performance
Recommendation is raised to communicate the need and track the required work. Otherwise, the
workflow ends.

Manage Performance Recommendations
Persona: Analyst

If a GE Digital APM User identifies an opportunity or need for improvement, then a Performance
Recommendation is raised to communicate the need and track the required work.

Refer to the Manage Performance Recommendations workflow documentation.
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About the Report Configuration Page

The Report Configuration page enables you to:

+ Configure your preferred logo for the SQL Server Reporting Services (SSRS) reports.
You can change the logo to the logo of your organization or another custom image that you prefer. By
default, the GE Digital logo appears in the SSRS report.

+ Configure settings to store and manage the reports after a job for printing reports in bulk is successful.

Access the Report Configuration Page

Procedure

+ Inthe module navigation menu, select Admin > Operations Manager > Report Configuration.
The Report Configuration page appears.

Operations Manager\

Report Configuration

Bulk Report Storage Path

Wlecalhost\C:\SSRSReports

Bulk Report Storage User Name

jsmith@demain.com

Bulk Report Storage User Password

Bulk Report Storage Threshold (Days)

100

Raport Logo

®
(®) customiogo

Choose File No file chosen

only jpg.jpeg.png.bmp format is supported with maximum 1M8 size.

Configure Logo for the SSRS Reports

This topic describes how to configure the logo for the SQL Server Reporting Services (SSRS) reports.

Procedure

1. Access the Report Configuration page.
2. Inthe Report Logo section, select the logo for the SSRS reports.

Note: The GE Digital logo is selected by default.
+ If you want to configure a logo other than the default GE Digital logo:

a. Select Custom Logo, then select Choose File, and then navigate to the folder that contains the
image.

b. Select the image that you want to configure as a logo for the SSRS reports, and then select
Open.
The image that you selected appears beside the Custom Logo button.
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Note: For a logo, the size of the image must be less than or equal to 1 MB, and the image must be in
one of the following formats:

*+ Jjpeg

+ Jpg

« .bmp

* .png
3. Select 1,

The configured logo replaces the existing logo, and it appears in all the newly generated SSRS reports.

Configure Storage Settings for the Reports

This topic describes how to configure the path where you want to store the printed reports, the
credentials of the machine in which the reports are stored, and the number of days after which the
reports will be deleted.

Procedure

1. Access the Report Configuration page.
2. Asrequired, enter values in the following boxes:

a) Bulk Report Storage Path: Enter the path where you want to store the printed reports.

Note: You must create the path according to the Universal Naming Convention (UNC). The
following example provides information about the path constructed using the UNC naming system:

+ \\HostName\Share, where HostName is the host name of the computer and Share is the
name of the shared folder

b) Bulk Report Storage User Name: Enter the user name that is required to access the machine in
which the printed reports are stored.

c) Bulk Report Storage User Password: Enter a password for the user name that is required to
access the machine in which the printed reports are stored.

d) Bulk Report Storage Threshold (Days): Enter the number of days after which the .zip file for the
printed reports will be automatically deleted from the stored location.

3

3. Select 1.
The printed reports will be stored in the specified path, and you can access the machine in which the
reports are stored using the credentials that you defined.
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About the APM Report Designer

You can create new report and save it in the Catalog folder or edit an already existing report in the Catalog
folder by using the APM Report Designer in Microsoft Visual Studio.

The APM Report Designer is divided into three sections:

+ APM Report Browser pane: This pane displays the Catalog folder structure. This pane contains
buttons that allow you to perform basic operations such as, Login, Logout, Open, New and Deploy.

+ Solution Explorer pane: This pane contains the details of the report that you have created.

- Design workspace: This workspace displays the report. This workspace contains two sections:
Design and Preview. The Design section allows you to define the report layout. When the report
layout is complete, you can view the report in the Preview section.

Access the APM Report Designer

The APM Report Designer allows you to create a new report and modify the report.

Before You Begin

+ Install the APM Report Designer.

Procedure

1. Onthe GE Digital APM Server, open SQL Server Data Tools.

2. On the Tools menu, select APM Report Designer.
-or-
On the View menu, select Other Window, and then select APM Reports Browser in the list.
The APM Reports Browser pane appears.
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APM Reports Browser

1] Mew |_|E| Open Deploy Logout

3. Select Login.

4. Enter the Username and Password, and then in the DataSource list, select the datasource.
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APM Reports Browser * [0 X
1] Mew |_|E| Open Deploy | Login Logout

Uszer Mame

Password

DataSource | S0L14 V400_TEST QA 20150716 -

Note: The Login button is enabled after you enter the User Name and Password.

5. Select Login.
The Catalog folder structure appears in the APM Reports Browser pane.

© 2020 General Electric Company



APM Reports Browser * [0 X
1] Mew |_|E| Open Deploy  Login Logout

[C1 Personal
[Z3 Public

Create a Report

Procedure

1. Access the APM Report Designer.
2. Inthe APM Reports Browser pane, navigate to the Catalog folder where you want to save the report.
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APM Reports Browser * [0 X
1] Mew |_|E| Open Deploy  Login Logout

[C1 Personal
[Z3 Public

3. Select New.
The Create new report window appears. The window contains two sections - The left side displays
the Catalog folder structure and the right side displays the fields.

© 2020 General Electric Company
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( Create new report E x )

[Z1 Personal D
(23 Public
Default Caption

Description

Datasource (Query/Dataset) Drop query/dataset here to set datasource for this report

Subreports Drop report(s) here to add sub reports to this report

Ok Cancel

4. Inthe Create new report window, provide the following values:

ID: Identification name of the report. The field must be unique.

Default Caption: The caption of the report.

Description: The description of the report.

Datasource (Query/Dataset): Datasource for this report. You can assign a datasource by adding a
query or dataset from the Catalog folder. You can add a query or dataset through the drag-and-
drop method.

Subreports: the sub reports that you want to assign to this report. To assign sub reports, navigate
the location that contains the report and drag and drop the report.

Note: You can not save a report in a folder, if the folder name or the parent folder name contains the
special characters suchas;?: @ &=+, $/* <> |.In addition, you can not save a report in a personal
folder if the user id contains the special characters. For more information, consult MSDN
documentation regarding creating, deleting or modifying a folder.

5. Select OK.
The new report appears in the Solution Explorer pane.

16
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Solution Explorer - =X
o4 | - @R s -
Search Solution Explorer (Ctrl+;) P~

] Solution 'APM Reports' (1 project)
4 1 APM Reports
Shared Data Sources
Shared Datasets

Next Steps
+ Define the Report Layout.

Define the Report Layout

Before You Begin

« Create anew report.

Procedure

1. Inthe Solution Explorer pane, select the report that you created.
The report layout appears in the Design workspace.

© 2020 General Electric Company
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£ Preview

Heading
merld]um SubHeading

=] Row Groups il Column Groups
= (Details) -

2. As needed, in the Design workspace, modify the report layout.
3. If you want display the UOM in the SSRS Report, enter the following expression in the Report Designer.

Fields!<nameofthefield>.FormattedValue

Note: If the query used to create the reports is in formatted mode, then only the UOM will appear in
the Reports. For detailed information on formatted mode, refer to the Queries documentation.

4. If you do not want display the UOM in the SSRS Report, enter the following expression in the Report
Designer.
Fields!<nameofthefield>.value

5. Select the Preview section to view the report layout.
Note: Enter the Login name and Password that were used to access the APM Report Designer.

6. Select .
The report layout is defined.

Next Steps
+ Deploy the Report.
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Deploy the Report
About This Task
Note: You can deploy the report after previewing. The report is then added to the Catalog folder.

Procedure

1. Inthe APM Reports Browser pane, select Deploy.

APM Reports Browser * O X
1] Mew |_|E| Open|Deploy | Login Logout

7 Personal
L3 Public

The Deploy Reports dialog box appears, displaying the list of reports and the sub reports.
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2.

Deploy Reports I ﬁ—-—l

Following reports will be deployed. Click Ok to start.

Select OK.
The Deploy Reports dialog box closes and the new report appears in the Catalog folder.

Modify an Existing Report

Before You Begin

The report is already created and appears in the Catalog folder in the APM Reports Browser
workspace.

Procedure

1.

20

In the APM Reports Browser pane, in the Catalog folder, navigate and select the report that you want
to modify.

Select Open.

The Create new report dialog box appears.

As needed, modify the following values to the fields:

+ Datasource: The datasource for this report. To assign a datasource, drag and drop the query from
the Catalog folder.

+ Subreports: The subreports that you want to assign to this report. To assign subreports, navigate
the location that contains the report and drag and drop the report.

Note: The ID and the Default Caption field are unique and should not be modified.

Select OK.

The updated report appears in the Design workspace.

In the APM Reports Browser pane, select Deploy to publish the changes to the Catalog folder in the
GE Digital APM.
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Open a Report from the Catalog

Reports are saved in the Catalog folder and you can view the reports through Catalog.

Before You Begin

+ You must have required permissions to access the Catalog folder.

Procedure

1. Access the Reports page.

2. Select Browse.
The Select a report from the catalog window appears, displaying the Catalog folder structure.

3. Select the report, and then select Open.

Note: If the query on which the report is generated contains parameters, the Enter Parameter
Values window appears. Provide the parameter values, and then select Done to view the report.

The selected report appears in the Report page.

View a Report

Before You Begin

+ You must have privileges to view the report.

Procedure

1. Access the Report page.
2. Select the report that you want to view by selecting the link in the Path column.
The report appears.

Note: To view a translated report, in addition to setting the Security User's culture via Security
Manager, you need to set the browser language to that culture. For example, to view a report in
German language, you need to set the browser's language to German.
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About SQL Server Reporting Services Workspace

The SQL Server Reporting Services stores the reports that can be viewed and managed in GE Digital APM.
To integrate SQL Server Reporting Services with GE Digital APM application, you must define the SQL
Server Reporting Services instance that you want to use for a given GE Digital APM database.

The Operations Manager application provides a feature that lets you configure the SQL Server Report
Server. After you have defined the SQL Server Reporting Services instance that you want to use for a given
GE Digital APM Server and data source, GE Digital APM will use that Report Server for storing the reports
that are created and accessed on that GE Digital APM Server and database.

Access the SQL Server Reporting Services Workspace

Procedure

1. Inthe module navigation menu, select Admin > Operations Manager > Connections.
2. Inthe Connections page, select SQL Server Reporting Services.
The SQL Server Reporting Services workspace appears.

Operations Manager \

SQL Server Reporting Services =

Server Name

domain.com

Web Service

ReportServer_sql11

User Name

user

User Password

.......

User Domain

MAYBERRY

Configure GE Digital APM to Use Reporting Server

Procedure

1. Access the SQL Server Reporting Services Workspace on page 24.
2. Enter the required values in the following fields:

a) Server Name: Enter the name of the server on which SQL Server Reporting Services (SSRS) has
been installed and configured.

Note: If you do not specify the protocol for the server, HTTP will be assumed. If the SQL Server
Report Server is a secured server, you can type HTTPS://<Server Name> to indicate that an HTTPS
connection should be used. If the SQL Server Report Server is not secured, you can type HTTP://
<Server Name> or you can omit the protocol and simply type the server name.
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b) Web Service: Enter the name of the Report Server Virtual Directory that has been created for the
instance of SSRS that you want to use for the current GE Digital APM Server and data source.

If the SQL Server Report Server for this data source has not been defined, the Web Service will be
set to Report Server by default, which is the name of the virtual directory created for the first SQL
Server Reporting Service instance that is installed on the given server. You can modify the default
value if needed.

If the server specified in the Report Server text box contains multiple instances of SSRS, you must
specify the virtual directory of the instance that you want to use for the current GE Digital APM
Server and data source.

¢) User Name: Enter the user name to access SSRS.
d) User Password: Enter the password to access SSRS.
e) User Domain: Enter the domain name to access SSRS.

3. Select 1,
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Deploy Reports for the First Time

Results

The following table outlines the steps that you must complete to deploy and configure this module for the
first time. These instructions assume that you have completed the steps for deploying the basic system
architecture.

These tasks may be completed by multiple people in your organization. GE Digital recommends, however,
that the tasks be completed in the order in which they are listed.

Step Task Notes
1 Install the Reports Designer. This step is required.
2 Set up the Reports Designer. This step is required.

Upgrade or Update Reports to V4.5.0.0.0

About This Task

The following tables outline the steps that you must complete to upgrade this module to V4.5.0.0.0. These
instructions assume that you have completed the steps for upgrading the basic GE Digital APM system
architecture.

These tasks may be completed by multiple people in your organization. We recommend, however, that the
tasks be completed in the order in which they are listed.

Procedure
+ Upgrade from any version V4.4.0.0.0 through V4.4.0.0.4

This module will be updated to V4.5.0.0.0 automatically when you update the components in the basic
GE Digital APM system architecture. No additional steps are required.
» Upgrade from any version V4.3.0.0.0 through V4.3.1.0.6

This module will be updated to V4.5.0.0.0 automatically when you update the components in the basic
GE Digital APM system architecture. No additional steps are required.

+ Upgrade from any version V4.2.0.0 through V4.2.0.9.4

This module will be upgraded to V4.5.0.0.0 automatically when you upgrade the components in the
basic GE Digital APM system architecture. No additional steps are required.

+ Upgrade from any version V4.1.0.0 through V4.1.7.4.0

This module will be upgraded to V4.5.0.0.0 automatically when you upgrade the components in the
basic GE Digital APM system architecture. No additional steps are required.

+ Upgrade from any version V4.0.0.0 through V4.0.1.0

This module will be upgraded to V4.5.0.0.0 automatically when you upgrade the components in the
basic GE Digital APM system architecture. No additional steps are required.

» Upgrade from any version V3.6.1.0.0 through V3.6.1.7.5

This module will be upgraded to V4.5.0.0.0 automatically when you upgrade the components in the
basic GE Digital APM system architecture. No additional steps are required.
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+ Upgrade from any version V3.6.0.0.0 through V3.6.0.12.9

This module will be upgraded to V4.5.0.0.0 automatically when you upgrade the components in the
basic GE Digital APM system architecture. No additional steps are required.

« Upgrade from any version V3.5.1 through V3.5.1.12.3
This module will be upgraded to V4.5.0.0.0 automatically when you upgrade the components in the
basic GE Digital APM system architecture. No additional steps are required.

+ Upgrade from any version V3.5.0 SP1 LP through V3.5.0.1.10.1
This module will be upgraded to V4.5.0.0.0 automatically when you upgrade the components in the
basic GE Digital APM system architecture. No additional steps are required.

+ Upgrade from any version V3.5.0 through V3.5.0.0.7.1
This module will be upgraded to V4.5.0.0.0 automatically when you upgrade the components in the
basic GE Digital APM system architecture. No additional steps are required.

+ Upgrade from any version V3.4.5 through V3.4.5.0.1.4

This module will be upgraded to V4.5.0.0.0 automatically when you upgrade the components in the
basic GE Digital APM system architecture. No additional steps are required.

Install the APM Reports Designer

Before You Begin
+ Install one of the following versions of Microsoft Visual Studio and the corresponding version of
Microsoft SQL Server Data Tools (SSDT):

Visual Studio Version SSDT Version

Microsoft Visual Studio 2017 Microsoft SQL Server Data Tools (SSDT) - Business
Intelligence for Microsoft Visual Studio 2017 (15.8.0)

Microsoft Visual Studio 2019 Microsoft SQL Server Data Tools (SSDT) - Business
Intelligence for Microsoft Visual Studio 2019

o Ifyou install SSDT for Microsoft Visual Studio 2019, install Microsoft Reporting Service Projects
(VSIX 2.6.2). For more information on how to install Microsoft Reporting Services Projects (VSIX
2.6.2), refer to the Microsoft SSDT documentation.

Note: The following versions of SSDT are supported with Microsoft SQL Server 2016:

o 2017 (15.8.0)
o 2019

Procedure

1. Onthe machine that will serve as the APM Reports Designer, access the GE Digital APM Distribution
package, and then navigate to the Admin folder.

2. Run Setup.exe.
The Meridium Admin - InstallShield Wizard window appears.
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Meridium Adrmin - InstaliShield Wizard [

Welcome to the InstallShield Wizard For
Meridium Admin

The IngtallShield 'Wizard will install Mendium Admin on your
computer. To continue, click Mest

< Back [ Meut » ][ Cancel

3. Select Next.
The License Agreement window appears.

Meridium Adrmin - InstallShield Wizard S

License Agreement

Pleaze read the following license agreement carefully.

EMD-USER LICEMSE AGREEMENT FOR MERIDIUM SOFTWARE

[ »

IMPORTAMNT - READ CAREFULLY

[.m

Thiz program containz material that iz propnetamy and confidential to Mendium, Inc. and iz
protected by copyright law and intermational treaties. Uze of thiz program ig limited and
restricted by the terms of a license agreement with Meridium, Inc. This program may not be
copied or distibuted except az zpecifically permitted in the licenze agreement. Ay
unauthonized use, reproduction or digtribution of this program can result in severs civil ar
crminal penalties and will be prosecuted to the masimum extent pozsible. v'ou may not
alter, remove or destrop any copyright fotice or confidential, proprietary, secret or ather
gimilar legends placed on ar with Meridium products. o=

@ | accept the terms of the license agreement

) | do not accept the terms of the license agreement

[rztallS higld

< Back ][ Mext » ][ Cancel ]
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4. Read the License Agreement and, if you agree, select the 1 accept the terms of the license

agreement check box, and then select Next.
The Select Installation Location window appears.

Mendium Admin - InstallShield Wizard

e

Select Installation Location

G [nztall b enidium Admin to;
C:%Proagram Filez\k eridium

[niztallS hield

< Back ][ Mext >

] [ Canicel

5. Select Next to accept the default location.
The Select the features you want to install window appears.
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Mendium Admin - InstallShield Wizar

=5
Select the features you want to install \ N ‘

Select the features you want to install, and dezelect the features you do not want to inztall,

Dezcription

Adds the AP extention for
creating S5RS Repart ta
Wizual Studio

14| I |

4 .40 MB of zpace required on the C dive
J62405.41 ME of space available on the C drive
InztallShield

¢ Back ][ M et = ][ Cancel

6. Select SSRS Data Processing extension for Visual Studio, and then select Next.
The Complete the Installation window appears.

Meridium Adrin - InstallShield Wizard |

Complete the Installation

Click the Inztall button to continue.

If oLy want ta review or change any of pour installation settingz, click the Back button. Click
the Cancel button to exit the wizard.

InztallS hield
|
|

_ T T — — T —

7. Select Install.

[ ¢ Back ][ Inigtall ][ Cancel
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The Setup Status window appears, displaying a progress bar that shows the progress of the

installation process.

Mendium Admin - InstallShield Wizard

Setup Status

35|

The InztallS hield wizard is installing keridium Admin

Installing

C:h. MDECBSBED-OFES-4DSE -8B CO-9DE E 9F3970AE Maetup. exe

[rztallS higld

Cancel

When the SSRS Data Processing extension for Visual Studio is installed, a message appears, indicating

that the installation is complete.

Meridium Admin - InstallShield Wizard

Installation is Complete

Meridium Admin have been installed successfully. Click the
Finish button to close this window.

8. Select Finish.
The Meridium Admin - InstallShield Wizard window is closed.
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9. Asdescribed in the following table, navigate to the paths corresponding to the Microsoft Visual Studio
version installed in your system.

Visual Studio Version Path

Microsoft Visual Studio 2017 C:\Program Files (x86)\Microsoft
Visual Studio\2017\Professional
\Common7\IDE\CommonExtensions
\Microsoft\SSRS

Microsoft Visual Studio 2019 C:\Program Files (x86)\Microsoft
Visual Studio\2019\Professional
\Common7\IDE\CommonExtensions
\Microsoft\SSRS

10.0pen the RSReportDesigner.config file using a text editor (for example, Notepad).

11.Locate the following code in the configuration file, and then replace {meridiumserver} with the name of
the GE Digital APM server: <ServerUrl>http://{meridiumserver}/meridium/api/</
ServerUrl>

12.Save the configuration file.

Results

The APM Report Designer is installed.

Set Up the APM Report Designer

After installing the APM Report Designer plugin, you must set up APM Report Designer to interact with GE
Digital APM Server.

Before You Begin

+ Install the APM Report Designer.

Procedure

1. On the GE Digital APM Server, open Microsoft Visual Studio.
2. Onthe Tools menu, select Options.
The Options window appears.
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General

Add-in Security
AutoRecover
Documents

Extensions and Updates
Find and Replace

Fonts and Colors
Import and Export Settings
International Settings
Keyboard

Quick Launch

Startup

Synchronized Settings
Tabs and Windows
Task List

Web Browser

m

IBIue hd

[¥] Autornatically adjust visual experience based on client performance
Enable rich client visual experience
Use hardware graphics acceleration if available

Visual Studio is currently using hardware-accelerated rendering. The visual
experience settings automatically change based on system capabilities.

10 items shown in Window menu
10 items shown in recently used lists
Show status bar

Close button affects active tool window only
[7] Auto Hide button affects active tool window only

[ Manage File Associations ]

i T —— —
Cptions lilg
| | p| Visual experience
- Color theme:
4 Environment e

Lo ]|

Cancel

3. Onthe Options window, in the left section, select APM Report Designer, and then select General.

The MeridiumServerURL box appears in the right section.

Cptions

Search Options (Ctrl+E)

I Environment
I» Projects and Solutions
I+ Source Control
I» Text Editor
I+ Debugging
[ Performance Tools
I» Analysis Services Tabular Designers
4 APM Reports Designer
General
Business Intelligence Designers
Database Tools
F# Tools
HTML Designer
Office Tools
Package Manager
SQL Server Tools
Text Templating

»

m

a4 Misc
MeridiumServerlJRL

MeridiumServerURL

Lo ]|

Cancel

4. Inthe MeridiumServerURL box, enter the Meridium Web Services URL in the following format:

http://<server name>//meridium/api/
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Options s —— -

Search Options (Ctri+E) P

Environment MeridiumServerURL http:// <server_name:>//meridium/api/

Projects and Solutions
Source Control
Text Editor
Debugging
Analysis Services Tabular Designers
APM Reports Designer
General

]
AT TTTTI

Business Intelligence Designers
Database Tools

HTML Designer

Package Manager

SQL Server Tools

Text Templating

Windows Forms Designer MeridiumServerURL

A v AR v AR VR v L v

The APM Report Designer setup is complete.
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System Requirements
Reports System Requirements

License Requirements

This feature is available with the core GE Digital APM application; no specific license is required.

Additional Components Required

In addition to the basic GE Digital APM system architecture, your system must also contain the following
additional components:

+ Microsoft Visual Studio 2017 or 2019 Professional.
+ Microsoft SQL Server Data Tools - Business Intelligence for Microsoft Visual Studio 2017 (15.8.0) or
20109.

« APM SSRS Data Processing Extension plugin for Visual Studio from the Admin Installer.

Deploying Reports
After you have installed and configured the basic GE Digital APM system architecture, configure Reports.

Supported Features in APM Now

In the APM Now environment, SSRS report creation and modification features are unavailable. All other
standard GE Digital APM product features for this module are available.

SQL Server Analysis Services System Requirements

Hardware Requirements

The following hardware requirements outline the minimum hardware required for SQL Server Analysis
Services support in APM Metrics and Scorecards module. These requirements account for the GE Digital
APM software only. Additional hardware may be required on a SQL Server Analysis Services machine
where other components are installed. These requirements may not be sufficient, depending upon how
your system is configured.

« Two Processor Cores, 2+ GHz
- 8GBRAM
+ 25 GB of available hard drive space

Software Requirements

The following software components are required on any machine that will serve as the SQL Server
Analysis Services server.
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Software Name and Version Where You Can Obtain It Required?

SQL Server Reporting Services 2012 Microsoft Yes
(Multi-Dimensional mode only)

-or-

SQL Server Reporting Services 2014
(Multi-Dimensional mode only)

SQL Server Report Server System Requirements

38

Hardware Requirements

The following hardware requirements outline the minimum hardware required for any machine that will
serve as the SQL Server Report Server. These requirements account for the GE Digital APM software only.
Additional hardware may be required on a SQL Server Report Server machine where other components
are installed. These requirements may not be sufficient, depending upon how your system is configured.

« Two Processor Cores, 2+ GHz

- 8GBRAM

+ 25 GB of available hard drive space

If you are using a virtual machine (VM) to host your SQL Server Report Server, we recommend that:

+ You increase the physical server CPU and hard drive space requirements by 20% to ensure that the
application will perform equivalently in a virtualized environment.

+ You double the physical server memory requirements.

+ Each VM have its own dedicated processor cores and memory allocation to ensure appropriate
performance.

GE Digital APM supports Hyper-V and VMWare platforms.

These requirements may not be sufficient, depending on how your system is configured. Parameters that
affect the hardware requirements include the number of users, modules purchased, database size, and
other factors that can vary from one customer to another. For help refining your specific system
requirements, consult a member of the GE Digital APM Professional Services department.

Software Requirements

The following software components are required on any machine that will serve as the SQL Server Report
Server.
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Software Name and Version | Where You Can Obtain It Required?

SQL Server Reporting Services | Microsoft Yes
2012

-or-

SQL Server Reporting Services
2014

-or-

SQL Server Reporting Services
2016

Reports URLs

Reports URLs

Behavior of Meridium APM
Server and Add-ons
Installer

If it is not found, the installer
will close.

There is one URL route associated with reports: ssrs/viewer. The following table describes the various

paths that build on the route, and the elements that you can specify for each.

Element Description Accepted Value(s) Syntax
Catalog Item Path Specifies the path and name of | Catalog item path #ssrs/viewer/
the report that you want to Catalog Path
open.
Example: Reports URLs
Example URL Destination
#ssrs/viewer/Public\Meridium Opens the report named 'Comprehensive Analysis' in the
\Modules\RCA\SSRS Report Viewer.

\ComprehensiveAnalysis
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